
Introduction:

DAZ Textures are high quality but they are not quite game ready. The image scale is not in powers of two and we want to be ab le to use the color palette 

to choose many different colors with only 1 game texture. Saving game data file size and increased performance. There is also a very nice 'trick' I make 
use of know how lighting works in the game engines to boost our 3D capabilities with just a little play on the texture itself .

This entire workflow is written in such a way that is very easy to read and follow. There are a lot of pictures to help guide you through this process. The 

process has many steps and some of them make no sense whatsoever. Haha!! Stay with me on this journey and see it to the end and you will see some 
excellent quality results with high performance in mind as well.

In reference to how many Polys a Mesh has. There are a number to methods to reduce poly counts in meshes. I choose to use Decimator from DAZ 

Studio. I will show the process below for those that are interested. First…let us examine poly counts and what they mean to a game engine.

The game designer must take into consideration of the platform they are designing to. I am going to make an assumption that we are designing for Mid to 

High End Desktops and Notebooks (with Non-Integrated) graphics cards. For baselines we can use Passmark for CPUs and GPUs for a reliable indication of 
where we should be when designing a 'Next-Gen' game. Hardware of today have little trouble with many millions of polys on the display at once. Poly 

counts are no longer an issue…mostly. I did some performance tests in excess of 30,000,000 polys with very low draw calls (ma terials were the same).

What we really want is Texture/Material optimization as well as reducing the Polys in meshes to an 'acceptable level' without sacrificing high end quality. In 

this workflow I show both and we will not be lazy and cut corners. Haha!! Seriously, we need to touch every model and texture prior to importing to the 
game engine. Simply do not fall into the lazy trap. DAZ Artists and most artists in general have little consistency and utter disregard for materials. There 

are a few rare exceptions to this but as designers we must rectify this in our workflows.

For hair we should be within the range of 20,000 to 50,000 polys. If less can be done…go less. It depends highly upon each mesh. Most of our meshes 

through this workflow shall be optimized to 1 or 2 materials in the game engine….1 or 2 draw calls. A very well optimized model.

Passmarks:
CPU Benchmarks: http://www.cpubenchmark.net/high_end_cpus.html
Aim for a CPU 7500 or better. 9500 or better CPUs are reasonable now with Motherboard Bundles.

16GB of RAM should be the starting point.

GPU Benchmarks: 
http://www.videocardbenchmark.net/high_end_gpus.html
Aim for GPU 3500 or better. A GTX 950 is very reasonable and a 5251 score. Radeon R9's have some nice pricing as well and nice scores.

Caveat: Even though we are using Unity for the game engine importation here this workflow will work for any game engine. Since the fo rmats are PNG 

and FBX just about everything can import these formats.

Please bear in mind that prior to starting this workflow you should get familiar with each software below. I do have pictures for many things but inserting 

characters and hair in DAZ Studio is very important. I will make the assumption that you are familiar with this process but I will have pictures during the 
workflow to jog memories as well. Enjoy.

NOW…on to HAIR!! Haha!!

Cheers
Don Anderson (aka Olander)

Note: Please see the other workflows for both Characters and Clothing. For DAZ content licensing information please see the s eparate PDF DAZ Software 

and Licensing Information. For DAZ character morphing information I have made a PDF document on what the basic costs to get a solid start with DAZ 
Studio. It removes some confusion between the models as well.

Olander's Hair Shader (Genesis Hair): from the Asset Store  gHairShader.shader

Textures: PNG (almost exclusively)
- Lossless Format

- Excellent Memory Footprint

- Alpha is built into the texture itself

*for a True Alpha Channel we will use TIF (PSD can also be used but the size is much larger). GIMP can export both formats.

Software Required:
GIMP v2.8 (for PNG texture processing and Normal Maps)
*Photoshop may be used but the Normal Maps in it are tedious and not very good. PNG out put is good but I think GIMP is actua lly better.
https://www.gimp.org/downloads/

Install Location Highly Recommended: C:\GIMP 2

GIMP Normal Map Plugin
*Creates fantastic normal maps
http://registry.gimp.org/node/69    (gimp-normalmap-win32-1.2.1.zip)

To install, extract the normalmap.exe file to your GIMP plugins directory.
This directory is usually located at:
C:\GIMP 2\lib\gimp\2.0\plug-ins

Then extract the 3 dll files to your GIMP bin directory.

This directory is usually located at:

C:\GIMP 2\bin

DAZ Studio Pro v4.9 (Free)  v4.7 & v4.8 also work if you already have the old versions
http://www.daz3d.com/
*Create an account and download.

Highly recommended to install in C:\DAZ 3D

Highly recommended to make a DAZ Exports folder to export everything from DAZ in one location. Simplifies many things.

Path for DS4.x Default Content
C:\DAZ 3D\Downloads

Olander's DAZ Hair to Unity 5 (Game Engines)
Thursday, May 12, 2016

6:40 PM
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C:\DAZ 3D\My Library

C:\DAZ 3D\Render Library

C:\DAZ 3D\Scenes

Path for Content Management Service
C:\DAZ 3D\cms
Note: Default Path  C:\Users\<ComputerName>\AppData\Roaming\DAZ 3D\cms

Blender v2.77a  (Free)

www.blender.org/download/

*MayaLT is also a good alternative and is not expensive. The workflow is based upon Blender though.

Unity v5 (any version)  (Free or Pro)
http://unity3d.com/get-unity
*Pro is used in this workflow, however, Personal may be used equally.

Workflow:

Right, so let us get started shall we?

Folder Structure Set Up:
Now we collect all of our files to place them in our backup. You can name these whatever you wish….whatever makes sense to you.

Open DAZ Studio Pro

*I have provided with this PDF a DefaultScene.duf file. Open this file since it as lighting and many camera views already set up. Handy. In Preferences I 

set this as the file DAZ opens by default as well.

Add Genesis 1 or Genesis 2 Male or Female to the Scene. Here I will use Genesis 2 Female for the entire Workflow.

Mesh = The FBX mesh that will be Imported into the game engine
Mesh Exported = Optimized OBJ exported from DAZ Studio
Original Textures = DAZ Studio JPGs for the Object
Software Files = Blender Files and DAZ Studio Scene DUF File
Textures = PNG Processed Textures for the game engine
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Your Genesis 2 Female model should be in a T-Pose 

and ready to go.
Male or Female may be used but the female is used for 

the workflow.

Go ahead and Save As >  G2F Hair Fitting.DUF
*Any name that you choose is fine.

These should be placed in your Scenes Folder here:

C:\DAZ 3D\Scenes

Please Note: You may use any hair you wish during this process. I am simply using a hair that covers a wide array of usual fitting issues. Matter of 

fact all of the Pure Hairs by DAZ are excellent and should be in your hair library as they are very good excellent hair with a lot of options (morphing) 
within the hair.

Now we are going to add hair to our Genesis 2 Female Character. I have chosen Pure Hair Catwalk for this workflow for a couple of reasons. It was 

originally made for Genesis 1 so I will be showing how to Fit a Genesis 1 Hair to a Genesis 2 Model. Hair fits both Male and Female and a lot of hair 
models actually work well on both genders. Catwalk is one of those hairs that can work for both male and female.

Let us Save As  Hair Catwalk <= Or whatever hair you are using

You will have to have a look at where your Scenes folder is. Mine is C:\DAZ 3D\Scenes

http://www.daz3d.com/pure-hair-catwalk

When you have Genesis 2 selected in the 

Scene Tab and then double click on the Hair icon 
you will see and Auto-Fit utility pop up.

Genesis 1 and 2 can fit the same items. So fit this 

like it was made for Genesis.

Click Accept

The hair will be fitted as shown.

Now select our Hair in the Scene Tab then press 

the square navigation box

   Workflows Page 3    

http://www.daz3d.com/pure-hair-catwalk


Your viewport will look like this

Now we want to check the 'Fit' for any clipping to 

the model. We also need to make any mesh 
adjustments to the Hair to give some spacing 

between the hair and the body.

Many DAZ Hair come with Morphs which can be 

used to make different varieties of hair with the 
same exact mesh.

To see what the hair can be shaped to and such 

you will click on the Parameters Tab
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As you can see from 

the picture on the 
right that there is a 

lot of variety to this 
particular hair.

Needless to say…this 

can be a lot of hair 
styles from this same 

base model. Which 
also means the same 

textures and 
materials in the game 

engine will apply to 
all of them.

*wink*

Shall we continue? 

Haha!!

We inspected our hair to model. The hair 

actually fits really well. We need spacing for 
game engines to keep clipping down during live 

animations. You can see here that the hair is a 
little to close to the breasts. Let us resolve this.

You can see the nice spacing needed for a game engine cloth and animation simulation. 

Make any other adjustments you wish then we move along. This hair looks great.

We will add a Material to this hair later. Right now we are ONLY interested in the Raw 

Mesh of Hair.

Save your scene prior to Decimating (poly reduction) our Hair Mesh. We will need to re-

open this scene for the Material/Textures portion.

Again…if you will use your own solution for reducing poly counts…please skip down to 

where we add our Material to the hair.

Select Decimator then click
Prepare to Decimate 

You can see here in the Scene Info Tab what is what in the scene.

We can see that PH Catwalk has 43,328

Let us see what we can do with this, shall we?
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Once you have done the Decimation you will notice the mesh 

looks kind of horrible. Like poorly handled aluminum foil.

Pay no attention to the Crinkle. Let us go straight 

into the foray. Okie…have to lay off the movies 
and coffee!

Let us add a Smoothing Modifier to our Hair then 

Set the Polys to our target of 20,000 and we will export
To see if the mesh held together correctly.

Click Done….DO NOT SAVE the scene file.
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Let us add a Smoothing Modifier to our Hair then 

add some smoothing iterations to prepare the 
mesh for export.

With the hair selected in the Scene Tab follow the 

picture to the left.

Now select the Parameters Tab and select the 

Mesh Smoothing Option. Increase your iterations 
until some or most of the crinkle is smoothed out. 

Too many iterations and the mesh will become too 
flat. Some where between 5 and 15 is usually 

good enough.

You can see here the hair mesh looks quite nice. I 

have already turned off our Genesis Model for our 
next step….

We will now Export this mesh to OBJ. 

Wait what? Isn't that some old…old..old..old 

format?

Sure is…and it is perfectly clean. Exactly what we 

need. This is basically a Check OBJ to validate our 
Decimation values. With some experience you can 

do this in one or two tries. Practice makes perfect.
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Export as Shown as OBJ.

A Game Engine Note. Some Game 

Engines do not allow spaces in the 
name of the files. So it is recommended 

to use naming conventions with an 
underscore in place of the space. In this 

example I will use: Hair_Catwalk for 
the file names of the OBJ and FBX (later 

on)

I have a special DAZ Exports folder that 

I always export to as mentioned in the 
beginning.

Press Accept then fire up Blender

In Blender now. Whew! Import your Hair Catwalk as Wavefront OBJ

Don't worry…the hair is actually in the proper orientation. Rotate the camera 

around and let us inspect our mesh. Looks great! Could go even lower if you want 
to find out where the mesh breaks down at. I am fine with 20k so time to do the 

DAZ Optimization then Export the REAL OBJ! Yay!!

Okie….Optimize Time! If you have not done so open a New Scene. Then once complete open your Hair Catwalk scene. Now we are back to a 

Brand New Shiny….ere…right. We should have the viewport as shown with our hair selected. In this scene you will have noticed I turned off our 
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Brand New Shiny….ere…right. We should have the viewport as shown with our hair selected. In this scene you will have noticed I turned off our 
Genesis model by ticking down the Eye in the Scene Tab.

Here is where DAZ gets strange. Follow carefully here. The process is not obvious and not simple.

DAZ 'things' have what are called Surfaces. These surfaces can be called Materials in game engines for reference. Each Surface would be one 

draw call. So we must combine LIKE Surfaces into Surface Groups. To figure out what surfaces are the same or not we must add a material 
and inspect the Surfaces Tab.

Here I added the Auburn Material

In the Surfaces Tab you will notice we have four Surfaces or Materials if you will.
What we need to do is select each one individually and check the Diffuse slot for 

textures. DAZ Studio can layer textures so we need to know if the 'Material' is a 
layered (LIE) type or singular diffuse. So let's have a look.
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Texture A:
Bangs
Base
Top

Texture B:

Skullcap

Texture A Set and Texture B 

Set are both singular type 
diffuse. Most hair is but some 

are not! If you do happen to 
find a LIE Layered type 

Surface then you will open 
that. You can find LIE 

Layering tutorials.

Based upon what we found 

here we can combine 3 into 1 
from Texture Set A

So now we know….ohhh do we know. Haha!!

Here it comes….Surface Optimization! Yay!! So up at the icon bar in DAZ. Click the 

Surface Editor Tool. Then in the Tool Tab (I dock mine on the left side) you will 
set Geometry Editor
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Now we select Surfaces in the Target Group then Base in the next drop 

down. Different hair will have different surface names. Remember from 
above what the 'Surface' was named? Check the pic again if you forgot.  

We had Texture A Set and Texture B Set.

So have a look at the Left
Bangs
Base
Skullcap
Top

Based upon what we found. We can combine LIKE Surfaces into 1 

Surface for game engine optimization.

Texture A:
Bangs
Base
Top

Texture B:

Skullcap

How we do this is double check our main hair surface. You can see 

which surfaces will be our main if you select it and have a look into 
your viewport. We want the largest surface to act as our main. In this 

case Base will work nicely.

If for some reason you want the Bangs or Top to be a different color in 

your game for player options…by all means export this model as is and 
you will have your additional materials you can color separately.

1) To combine Click the + next to Base first <= main surface. It 

matches the Drop Down.

2) Click the + next to Bangs and Top <= These will go INTO the Base 

Surface.

3) Now click on Base (you don't have to but it is a good check that you 

have done everything right)

STOP! Once you do this…there is no going back! So make sure. 

Otherwise you will simply have to redo this.

Once you are sure. Click the Assign to Target Group button.

Click the - sign on the Base to remove the selection.

Now we need to Remove the Surfaces with Zero Polys in them.

Click on Bangs then Ctrl+Click on Top to highlight both

Now Right Click on either and choose Remove Selected Group(s)
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And finally this is our optimized hair. Ready for Game Engines near 

you! Haha!!

Now you can save your scene for backup later. We are going to finally 

export both our REAL OBJ mesh and get our Textures!

Let us export our optimized OBJ first. Same settings as before. You can overwrite the previous OBJ. Mine is named  Hair_Catwa lk.obj

Now we need to gather our textures. Return to the Surfaces Tab and click on the Diffuse icon. Then click on Browse
This will take you to where the JPGs are located.

We now are located in the following folder…

C:\DAZ 3D\My Library\Runtime\Textures\Michelle\PHCatwalk
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In this folder you will see all the JPG textures used with this hair model. Copy all of these to your Hair Catwalk game model folder. 

The sub-folder should be named: Original Textures
*This is your back up and reference

Textures (should already be copied to Original Textures○

FBX move to a folder named => Mesh  (this will happen shortly)○

OBJ move to a folder named => Mesh Exported  (this is your optimized OBJ)○

Blender file move to a folder named => Software Files  (sometimes there is a  .blend1  as well)○

DUF file move to a folder named => Software Files○

DUF Scene file =>  C:\DAZ 3D\Scenes○

Now we collect all of our files to place them in our model folders.

Once completed with copying and moving files then we are ready for the next step. Processing textures for the Genesis Hair Shader and importing 

the Hair Model into the game engine. This is the conversion to a universal FBX format or whatever format the game engine requires.

Fire up Blender and Import the OBJ  Hair_Catwalk.obj  located in your Mesh Exported Folder

Our hair is exported then imported properly and once again looks

Great! Now we need to fix the naming conventions of the model and 

mesh. This is not obligatory but I would recommend doing this because it 
makes knowing what the Mesh and Material ties are in the game engine. 

Some model naming is terribly not obvious. So let us just do this….takes 
less than 1 minute.

Model name:  Hair_Catwalk
Mesh Name: Hair_Catwalk
Material 1: Skullcap
Material 2: Hair

Now it is absolutely obvious which is which

Save as Hair_<NAME> Blender File for backup and reference 

later. 

And now we are ready for FBX export. Yeppers…that is correct. 

No need to apply textures and check UVs. We did that already 
right within DAZ Studio. Awesome right!?
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We are done with Blender. So go ahead and close it and DAZ Studio down. Or leave them up if you wish.

Fire up GIMP! One of my favorite toys. Haha!!

Textures! A custom Unity Hair Shader (Olander's Hair Shader) has been made by myself for Genesis Hair (any hair actually). It works in both 

Forward and Deferred as well as Gamma and Linear. So it fits everything just like the Unity Standard Specular does. This however is much more 
specific for hair.

So we have collected our PH Catwalk Hair textures. We want to use the textures as is for the colors. The quality is there so why not? The caveat 

here is you will need to add the Alpha Mask to the texture….which means every texture needs to have this done. Let us get to work. You can make 
your own colors as well by using HSL and Brightness Contrast (BC) adjustments in GIMP/Photoshop.

We will make the Normal Map. No need for the Bump from DAZ.○

We will need to copy our Original Textures to the Textures folder (Remember these will be for the game engine PNG import)

For Hair Coloring Reference here is a table that I made from the hair color chart (Olander's Standard Hair Tints Table). It shows colors of standard 

real hair as well as which base colors of DAZ Hair should be used to color HSL from. How you match up colors or create your own colors is 
completely up to you. There are other colors that can be added of course but in my opinion 24 textures for hair is plenty of variety.

Use this as a guide for visually aligning coloring on your textures with HSL.

We want a decent naming scheme for our game engine textures. Now we are going to rename the DAZ Original Textures to the naming I use.

Diffuse:  Hair_Catwalk_##  & Skullcap_Catwalk_##
The ## references which hair color code from the table below. I used the Row Number as the hair suffix. 
White Blonde _01
Medium Brown _12
Variations of a color simply add =>  b  c  d … after the number. This would happen rarely but can be done in the same naming conventions.

Highly Recommended Suffixes for textures.

Diffuse/Albedo:  no suffix   (Hair_Catwalk_01 … _24)
Normal Map:  _n   (Hair_Catwalk_n)
Specular Map:  _s   (Hair_Catwalk_s)  …  Not used in the new shader
Alpha Mask:  _m   (Hair_Catwalk_m)  …  Used in preparing the Diffuse Alpha
Transparency:  _tr   (Hair_Catwalk_tr) … This may be used when making the hair invisible while still leaving the mesh in place.
Ambient Occlusion:  _ao

For Olander's Hair Shader we will only use the Diffuse and Normal Map. The shader takes care of everything else. We will need the Alpha Mask to 

make proper transparency to the Diffuse PNG.

We will make a Normal Map from a Base Desaturated Texture using the GIMP Normal Map Filter...
Normal Map: Hair_Catwalk_n  (Skullcap needs no Normal Map)

Match up the original DAZ texture color to the table to get the reference number. ( _##)
*This texturing process can take some time. With key simulation in the Logitech Game Software with a G Key Mouse or G13 Gameboard very much 

speeds up the process once the key strokes are mapped down and programmed in. I can process all 24 hair textures with Alpha maps in just under 
30 minutes and for the tougher hair textures about 45 minutes.

Since this portion will take some time…for following along with the workflow simply choose a favorite hair color and use that.

These are all JPG…so let's convert them from GIMP straight away to PNG. Use GIMP to make these files and not a bulk converter. GIMP has 

excellent quality output. If you know your bulk converter is solid then go ahead (XnConvert is a good one) but I choose GIMP when it comes to 
high end quality.

Again, I would recommend with processing textures and other repetitive tasks that you invest in a programmable game pad like the Logitech G13 

or a mouse that has programmable key sequences by the click of a button. It really does make processing textures fun!

Remember that textures are in powers of 2 in game engines. Not so with DAZ. There are all sorts of shapes and sizes of textures. DAZ Studio 

simply figures it out. We want to be more explicit with game engines. Sure they can figure things out but we really want to set at least one of the 
dimensions correctly prior to import. It solves issues later.
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Catwalk is a good example of a strange texture dimension. One more reason why I chose this hair for this workflow. I am choosing the best of the 

dimensions in this case….2048 for the height. GIMP does a very nice job with Cubic. Make sure that Link is checked to maintain ratio!!

Some DAZ artists add a nice touch 

to the texture in the corner of the 
texture. We need to paint that 

Black since a game engine 
material will see that.

Not certain how DAZ Studio can 

simply not see that. Strange. 
Anyhooo…moving on

Note:  GIMP uses Export in lieu of Save As
Simply change jpg to png and click export. GIMP knows what to do.

Close the file. The one that is in the view part is still the JPG!! Remember this. No idea how many times I 

was editing the wrong pic. Haha!!

We should now have 2 of each. 1 JPG and 1 PNG  Go ahead and delete each JPG
*for speed you can view Detailed View and sort by type.

First we need to make our Normal Map. We can use the Bump provided by DAZ or we can make our own 

with a Golden Blonde or Red. Let's us use the Golden Blonde (_06 in this case). Drag that into the GIMP 
viewer.  Colors>Desaturate

Nice texture but it is simply too flat. We need to give it some 

fun to add that extra flavor in the game renderer.
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Colors>Brightness and Contrast

See how lively and vibrant the bottom texture is compared to 

the upper one? We are adding silky sheen and oils to the 
texture itself which basically means less tricks in the game 

engine.

Of note here you will change the Contrast 1st. Start from the 

Left and bring the slider Right until you see the 'Fog' or 
'Wash' start to disappear. This means you are at perfect 

balance. You will actually want to be just to the wash side 
(Left of Perfect balance). This takes some practice to see 

consistently but once your eyes get accustomed to seeing the 
fog/wash in a picture ALL of your camera pics can also be 

richer with more depth….even look like they are made with a 
3D camera.

Now adjust your brightness to the left to soften the pic a 

little. You will know. That is the only way I can explain it. 
Your eyes will tell you.

Anyhoo….onwards! We have our Base Texture.

Export this and save over what is already there….GIMP style!

Close the viewer.

Make a copy of this and name it Hair_Catwalk_ssm
This is for later in our texture processing.

Now we make the Normal Map! Once you see Normal Maps 

from GIMP in the game engine and how they react with 
lighting….you will never use anything else! Serious.

Normal Map Settings…as shown

Skin and Soft things….2.0 Min to 5.0 Max

Hair….3.0 Min to 7.0 Max

Rough things…Rocks and such  5.0 Min to 10.0 Max

I always use 3x3 for game engines…works very well. Then I 

split the difference on the ranges I have figured out with 
experience (lots of testing in different engines). 

When you make a normal map set the light roughly 1000 to 

1400 with a normal sunlight intensity. Then change that 
intensity down and watch the normal. It should be very subtle 

but defining…not too powerful. Less is more but too less 
is…well…too less. Haha!!

The acid test is when you see a normal in game and you 

cannot place your finger on why it looks so good…you have 
nailed it.

It is a combination of great texturing and subtle normals. 

They are a team.

Here is our normal map for Catwalk. Looks really good. This 

will work very nicely in the renderer.

Export it =>  Hair_Catwalk_n

Clear the viewer. Of course…right? Haha!!

Now drag and drop your nifty base texture (Diffuse) into the GIMP viewer

Filters>Map>Normalmap
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nailed it.

It is a combination of great texturing and subtle normals. 

They are a team.

Here is our normal map for Catwalk. Looks really good. This 

will work very nicely in the renderer.

Export it =>  Hair_Catwalk_n

Clear the viewer. Of course…right? Haha!!

Now we need to take our Textures and make them with an alpha transparency. We have a very nice mask with our hair. Every hair has one.
Note: At this point you should have 24 Hair Textures and 24 Skullcaps with colors matched to the Olander's Standard Hair Tints Table. For this 

portion of the workflow I am going to use a colorless hair texture since you may not have completed all 24 yet. The process is no different on any 
texture.

Drag your Hair_Catwalk_## into the viewer then Add a Layer Mask to this layer (Right Click).
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Now drag your Mask texture (Hair_Catwalk_m) into the viewer. GIMP will 

make a new layer with this texture on it. We need to make a Mask with this 
texture.

See how this texture/layer is selected? Now press CTRL+A or Select>All

Now press CTRL+C or Edit>Copy
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Now Click on the Black Layer Mask we added and press CTRL+V or Edit>Paste

A new temporary layer will appear which we will need to Anchor. Press CTRL+H or Layer>Anchor Layer

Now Right Click on the Mask Texture layer (Top one) and Delete that layer.

You should now have a very nice alpha diffuse RGBA texture. Export this and overwrite.

   Workflows Page 19    



Optional:

Olander's Hair Shader does not need this but it is a nice texture map to have.

Now we need to check our specular map:  Hair_Catwalk_s  & Skullcap_Catwalk_s

Some hair come with these and some do not. Using Brightness and Contrast you can make your own Specular map. Catwalk has a nice one 

so you can use this as a reference. To make the Specular Map you will turn your brightness down to -125 or so after desaturating a texture. 
Then using contrast to tweak in a very nice specular shine. This gives a nice silky appearance to hair. With our great Diffuse texture we can 

get a similar effect by playing with metallic/roughness in the shader. Hair specular maps make this easy mode.
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We are almost there! Whew! Not so bad right?

Fire up your game engine! Yeah! For this workflow we will be using Unty 5.4.0b17  still beta but stable and good to make certain this process will 

work with any version of Unity 5. I did test this workflow in UE4 and it works without issues. The material is set up a bit differently but it is not a 
complicated shader and is relatively simple to set up. For Unity 5 this is a shader that works much like the Standard Specular Unity 5 Cutout 

mode. This is a much softer blend shader and near perfect. The hair shader is also double sided and reacts properly with lighting.

So now set up a folder for Hair Catwalk. Inside this folder make three folders
Materials (This folder will be automatically created in Unity when dragging in the FBX but in the Mesh folder instead)
Mesh   (Notice the name is the same as your back up folder)
Textures   (Notice the name is the same as your back up folder)

Drag your Hair_Catwalk FBX into the Mesh folder
Drag your textures into the Textures folder

In your Mesh folder take your two materials and drag those to the upper Materials folder. Delete this empty folder. You could just move the folder 

as well in Unity. Other game engines do not like folders moving around….your choice.

Drag Hair_Catwalk into a test scene (I have one made specifically for testing mesh objects in appropriate lighting)
Set the hair to 0,0,0
If you export a Genesis 2 Female model (FBX straight from DAZ Studio) and import it into the game engine the hair will be positioned perfectly at 

0,0,0

Note: for changing to your various color options for the hair I highly recommend simply doing a Texture2D swap of the Diffuse. _MainTex is the 

slot to transfer in an out from. Providing the code to do this is outside of the scope of this workflow.

In the pictures there are no camera effects on the camera. These are raw pics to see how the textures and shader looks on the mesh. Looking 

really good. This shader can be controlled by weather to simulate wet hair as well as make metallic or plastic hair for dolls, statues, or droids.

Here you can see what my completed hair textures folder looks like after fully processed. The white is actually the transparency being shown in 

Windows. Remember here that if you make say 10 versions of Catwalk Hair these textures will work for all of those varieties.
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really good. This shader can be controlled by weather to simulate wet hair as well as make metallic or plastic hair for dolls , statues, or droids.

Choose from the Drop Down for shader type =>  Genesis>Hair Shader○

Now drag a Skullcap_Catwalk_##  into the Diffuse slot.○

Done○

Now edit the Skullcap material. In the Inspector the material will be diffuse alpha 

only. There is no need for a normal map for this since it will not really be affected 
by light. You can add a normal map of the skullcap if you wish to rid the warning 

note from Unity.
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Choose from the Drop Down for shader type =>  Genesis>Hair Shader○

Now drag a Hair_Catwalk_##  into the Diffuse slot.○

Now drag the Hair_Catwalk_n  into the Normal Map slot○

Done○

Now we edit the Hair material. The shader is simple, fast, and excellent to look at. 

It works in all modes.

Unity 5 Directional Light Settings. The color is just a smidge off white to add 

a little warmth to the sun light.
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Unity 5 Camera Settings. I have been using these exact settings to get a 

very nice graphical feel and high end result. These are standard Unity 5 
scripts and not the new Unity 5.3.4 or 5.4 Cinematic Effects. Feel free to add 

your own camera effects. The Olander's Hair Shader (Genesis Hair Shader) 
will work fine with just about anything.

Player setting comparison pics are shown below

Also below I am showing different comparisons to the rendering modes 

without the camera effects. Then I will show Deferred Linear with the 
camera effects for the final game shots.

You can see how flexible this hair shader is and the quality of the texturing 

and how it renders in game global lighting.

10:00   Forward, Gamma

   Workflows Page 24    



10:00  Forward, Linear

10:00  Deferred, Gamma
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10:00  Deferred, Linear, No FX

16:00   Deferred, Linear, No FX
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18:00   Deferred, Linear, No FX

10:00  Deferred, Linear, FX
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16:00   Deferred, Linear, FX

18:00   Deferred, Linear, FX
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Here are some rear shots of the hair shader in action.
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